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Introduction

A Redundant Array of Independent Disks (RAID) is a data storage scheme that uses two or more drives accessed in
combination to improve fault tolerance. Initially used with servers, desktop PCs are increasingly using RAID controllers
and extra ATA or SCSI disks. Newer system boards often have RAID controllers.

The HP Compagq Pro 6305 Business PC takes advantage of Serial Advanced Technology Attachment (SATA) and the
integration of RAID into Fusion Controller HUB A75 chipsets. The HP Compaq Pro 6305 Business PC products incorporate
RAID drive support through factory configurations. This white paper provides a basic overview of RAID technology,
supported factory configurations of HP Compagq Pro 6305 Business PCs, and other supported RAID configurations.

Basics of AHCI and RAID Technology

Definitions
Table 1: Basic AHCI and RAID Definitions

Acronym or term Description

AHCI Advanced Host Controller Interface, a specification for hardware and software, is a register interface for
SATA intended to add higher speed, NCQ and other features.

ATA Advanced Technology Attachment, an interface standard to connect mass storage devices to the
system.

BIOS Basic Input/Output System, also known as system ROM.

Chipset Collection of integrated circuits that controls the functionality of the system. Chipsets are designed to
work with specific processors.
Information file (.inf) used by Microsoft® operating systems that support the Plug & Play feature. When

INF installing a driver, this file provides the operating system needed, information about driver filenames,
driver components, and supported hardware.

Migration Term used to describe the movement of data from one configuration or usage model to another.

JBOD Just a Bunch of Disks. Logical drives concatenation

LD Logical Drive, a partition of a hard drive.

MBR Master Boot Record, the boot sector that holds the hard drive configuration information such as the
boot code and logical partitions.

MDD Meta Data, i.e. previous RAID configuration information

Mirroring Fault tolerance method using 100% duplication of data on two drives (RAID 1). After a failed drive is
replaced, the RAID controller automatically rebuilds the lost data from the other two drives. RAID
systems may have a spare drive (hot spare) ready and waiting to be the replacement for a drive that
fails

NCQ Native Command Queuing, an extension of the SATA protocol that allows hard drives to reorder read and
write operations for optimal performance.

0S Operating System, software that controls the functions of the system hardware and applications.
Third party module that is loaded by the System BIOS which provides extended support for a particular

Option ROM piece of hardware. The RAID Option ROM provides boot support for RAID volumes as well as a user
interface for managing and configuring the system's RAID volumes.

Parit Mechanism for data integrity used for data recovery. Distributed parity is used in RAID 5 (requires 3

y drives) to spread parity information so if any one drive fails, the other two drives can rebuild the data.

PCl Peripheral Components Interface, an interface standard to connect PCl devices to the system.

PCle PCl Express, a bi-directional serial version of PCI.

PnP Plug and Play, automated hardware discovery and configuration.

POST Power-0n Self Test, a BIOS-initiated routine that executes when a system is powered on. System
hardware is configured, component integrity is checked, and the system is booted.

RAID Redundant Array of Independent Disks, storage technology that combines multiple hard drives into a




single logical unit. Described in more detail in this document.

ROM Read Only Memory, non-volatile memory that is resistant to modification.
SATA Serial ATA, aninterface standard (replacing ATA) that connects SATA devices to the system .
Strip Set of data on a single hard drive in a RAID 0 volume.

Group of all strips going horizontally across all the hard drive members of a RAID 0 volume. Striping
Striping improves performance by interleaving bytes or groups of bytes across multiple drives so more than one
disk is reading and writing simultaneously.

USB Flash Drive, a storage device using flash memory and USB interface. It is used to install storage

UFD drivers during 0S installation.

Table 2: RAID Modes

Mode Purpose Minimal HDD Required
RAIDO Striped for Performance 2

RAID 1 Mirrored for Protection 2

RAIDO +1 Mirrored and Striped 4 (see note)
RAID 5 Striped with parity 3 (see note)

NOTE: Not supported on HP Compaq Pro 6305 Business PCs

Important RAID Configuration information

e RAID 1 and JBOD (RapidDrive) are the only RAID configuration that HP Compaq Pro 6305 Business PC products offer as
factory configurations.

o The preconfigured systems:
— Are complete RAID systems.

Have both drives installed.

Have the necessary Option ROM configuration.

Are preloaded and preinstalled with all required software.

Include a preinstalled operating system that is in mirrored mode out of the box.

Introduction to RapidDrive Technology

The current trend in the PCindustry is to maximize performance while minimizing costs. Customers and industry leaders
are demanding higher performance from lower cost PCs. The performance gains for processor and memory technology
has seen much improvement over the recent years. However, in the realm of traditional HDD storage technology,
performance gains have been minimal in relation to processors and memory. HDD access times can range anywhere
from 8 to 15 ms while memory access times are measured in nanoseconds. Since HDDs are the dominant storage
medium in PCs and portables, this is an industry-wide problem. When a system boots, most of the time is consumed by
seeking and reading the operating system (0S) files from the HDD. Boot times of up to 2 minutes or more are possible
from system power-on to full 0S functionality. System performance degradation can also occur during runtime with
large file 1/0 from applications such as MS Office and Adobe Photoshop. A significant amount of time can be saved if HDD
access time is minimized.



Basics of RapidDrive Technology

Rapid Drive from HP takes advantage of RAID/JBOD technology where various sizes of storage media are concatenated
to create a large disk volume. Rapid Drive is a combination of a solid state device (SSD) with a traditional HDD. The SSD
can be either single-level (SLC) or multi-level (MLC) cell based technology. The SSD is RAIDed with the HDD in a software
RAID configuration using the native chipset based JBOD capabilities to concatenate high performance SSD with high
capacity HDD as one drive resulting in high performance, high capacity storage subsystem. Once the SSD and HDD are
RAIDed into a single logical device, sector 0 (LBAO) will be at the beginning of the SSD and the last sector (MAXLBA) will
be at the end of the HDD as shown in the following illustration.

Figure 1: Linear view of SSD and HDD concatenated with JBOD

SSD 64 GB HDD
OS & some applications More applications and user data
Sector 0 MaxLBA

The 0S and all factory installed applications will be placed at the beginning of the SSD and subsequent applications will
naturally overflow into the HDD. In such a usage model, the 0S and frequently used applications, which are typically less
than the size of the SSD (64 GB), will enjoy fast access times from the SSD while less used applications and data reside in
the high capacity HDD.

RapidDrive Performance

According to Sandisk presentation for Winhec 2007’, for a typical 4KB request, the mechanical impact at the HDD level
accounts for ~95% of the entire transfer! The Data transfer time accounts for a fraction of actual disk access time (seek)
Random and sequential reads by the 0S have a major impact on system responsiveness. Random reads accounts for
more than 50% of the transfers. While launching a typical application the data files will be read in a sequential manner,
however, all the associated DLL’s (~100 in average) will be read and loaded in random from 5-6 disk locations per DLL.

Figure 2: Average Access Time Example

Formula: Average Access Time = Ave. Seek Time + Latency Time/2
Example: Average Access Time = 12 msec + 5 msec ~ 17 msec (5400rpm)

"Iri Trashanski, Director, Business Development, SanDisk, SSD To Solve The 1/0 Bottleneck presentation




HP RapidDrive comparison against HDD and SDD.

The RapidDrive configuration speeds up the random reads providing the faster seek times reducing the latency for
reads, which translates into greater speed in accessing data and more responsiveness for overall system. The following
figure show the PC-Mark 05 benchmark results comparing traditional HDD, SSD only and RapidDrive. The SSD only
configuration scores the highest but RapidDrive comes very close (within 80%).

Figure 3: Pc Mark 05 Storage scores on HP Compaq 6305 Business PC pro
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RapidDrive Price Performance analysis

The combination of SSD and HDD with software RAID results in the optimal solution from a price versus performance
perspective. User may choose to select smaller or larger mechanical HDD in combination with 64 GB SSD without
negatively impacting the overall PCmark05 score. Rapid Drive provides similar HDD capacity and SSD performance for
the fraction of the price.

RapidDrive Reliability

In the RapidDrive configuration the OS sees 2 storage devices as one, similar to Raid 0 with an exception of when it
comes to writing of data to the disk, RapidDrive will fill the SSD capacity first before over flowing data into the
traditional HDD. In Raid 0, if one component drive in the array goes down, all the data is lost because the data is stripped
across multiple drives. If one drive in a RapidDrive array goes down, the data that is on the remaining drives will survive;
Since SSD has higher reliability for mechanical failures then traditional HDD and RapidDrive configuration with 64 GB SSD
has MTBF of 2 million hours which makes it comparable (or exceed) to any enterprise-class HDD only configuration. A
typical HP factory installed image only uses SSD capacity and will not over flow into HDD. The HDD capacity is mostly for
user data. This makes HP RapidDrive system highly unlikely to mechanically fail and post the “non-system disks” error.
The 0S will almost always survive because of the high reliability of SSDs. RapidDrive configuration allows user to replace
the high capacity HDD without reinstalling the 0S. See section AMD Array Management Software (RAIDXpert) for details.



RapidDrive is more Eco Friendly

RapidDrive is the combination of SSD and traditional HDD. The SSD do not have any moving parts such as platter (Disk)
and head media, RapidDrive uses ~9% less power at Idle (Savings of ~4+ Watts).

Figure 5: Power (in Watts) usage for each configuration
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Single Drive AHCI Configuration

To take advantage of single drive AHCI support, a change is required in F10 setup. To run a single drive configuration in
AHCI mode:

Turn on or restart the computer by clicking Start > Shut Down > Restart the Computer.
2. Press F10 as soon as the monitor light turns green.

If you do not press F10 at the appropriate time, you must restart the computer, and then press F10 again to access
the utility.

3. Usethearrow keys to select Storage.
. Use the down arrow key to select Storage Options, and then press Enter.
5. Change SATA Emulation from AHCI to RAID Mode.

NOTE: Make sure the AMD RAID driver is loaded in the SW image prior to making the F10 setup change. The operating
system will not boot without this driver. The Pro 6305 factory SW image already contains this driver. This driver is also
provided as a softpaq at www.hp.com.



http://www.hp.com/

Basic RAID Types

This section provides a brief explanation of the supported RAID configurations for HP Compaq Pro 6305 Business PCs.

RAID 0 with two hard drives (Striped)

Even though HP supports RAID 0, it is not the recommended configuration for business PC users. Lack of redundancy
causes less than half the reliability of a single hard drive system since the Mean Time Between Failure (MTBF) of RAID 0
is equal to the MTBF of an individual drive, divided by the number of drives.

Table 3: RAID 0 with two hard drives (Striped)

First disk Second disk
Data Segment 1 Data Segment 2
Data Segment 3 Data Segment 4
Data Segment 5 Data Segment 6
Data Segment 7 Data Segment 8
Data Segment 9 Data Segment 10
Data Segment 11 Data Segment 12
Data Segment 13 Data Segment 14
Data Segment 15 Data Segment 16

In the previous table, each “Data Segment n” represents a group of data, known as a strip. In this case, each row
represents a stripe. RAID 0 represented in the table above shows how information is segmented, made into chunks or
strips, and stored across the stripes of the hard drive members of this RAID volume.

To better illustrate the concept of RAID 0 and striping, the following graphic shows how a sequence of data “ABCD..." is
stored in a RAID 0 mode. In this example, each letter represents a segment or strip. The graphic shows how the various
pieces of the information go to different hard drives. If any segment of RAID 0 fails, all information from all members is
lost.

Figure 6: Performance - RAID 0 with two hard drives

HDD 1

HDD 2



The HP Compagq Pro 6305 Microtower also allows for RAID 0 with three hard drives. However, reliability is less than a
RAID 0 configuration with two hard drives. RAID 0 with three hard drives is shown in the following figure.

Figure 7: Performance - RAID 0 with three hard drives
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RAID 1 with two hard drives (Mirror)

Because it is a very cost-effective way to increase system storage reliability and a great value proposition, RAID 1 is the
only RAID configuration that HP pre-configures for HP Compaq Pro 6305 Business PCs. RAID 1 provides high availability
with minimal performance impact, as well as greater reliability compared to a single hard drive configuration.

Figure 8: RAID 1 with two hard drives

HDD 1 HDD 2

RAID 1 has redundancy and hence is a true RAID. It more than doubles reliability because the MTBF of RAID 1 is equal to
the MTBF of an individual drive multiplied by the number of drives (2). In other words, the probability of one hard drive
failure on a given day is the square root of that same probability. Hypothetically, if the chance for a single hard drive
failure is 1:2000, then the chance that both hard drives failing in RAID 1 is 1:4,000,000.

Mirroring, segmentation, and striping have no real meaning in RAID 1. In the table and graphic, the data is arranged in
rows for representation of different pieces of data.



Table 4: RAID 1 with two hard drives (Mirror)

First disk Second disk

Data Segment 5 Data Segment 5
Data Segment 6 Data Segment 6
Data Segment 7 Data Segment 7
Data Segment 8 Data Segment 8

In the previous table, each “Data Segment n” represents a group of data, known as a strip. In this case, each row
represents a stripe. This table shows how information is duplicated in both hard drives. The size of the strips is mostly
irrelevant and not a configurable option.

To better illustrate the concept of RAID 1 and mirroring, Figure 3 shows how a sequence of data “ABCD...” is stored in a
RAID 1 volume. In this example, each letter represents a data segment. The graphic shows how the various pieces are
replicated for both of the hard drives; hence, if any one member of the RAID 1 volume fails, the information is kept in the
surviving members. After a hard drive failure, the user interface sends a notification so the failed hard drive can be
replaced. No user information is lost in this scenario.

Table 5: Reliability: RAID 1 - Mirroring

First disk

Second disk

Data Segment 1

Data Segment 1

Data Segment 2 Data Segment 2
Data Segment 3 Data Segment 3
Data Segment 4 Data Segment 4

Recommended configurations for HP Compaq Pro 6305 Business PCs
For performance value proposition, HP recommends factory configurations of the preinstalled RapidDrive.

e Preinstalled RapidDrive offering is available with SSD 64 GB combined with any valid size of HDD to create total
capacity of SSD+HDD size.
For best reliability, HP recommends factory configurations of the preinstalled Raid1.

e The preinstalled RAID1 offering is a RAID 1 volume of two identical SATA hard drives. You can select either two SATA
250GB drives, two SATA 500GB drives, or two SATA 1TB drives.

NOTE: HP Compaq Pro 6305 Business PCs support Microsoft Windows operating systems.

HP Compag Pro 6305 Business PCs are based on the Fusion Controller HUB A75 chipset, which is a combined hardware
and software RAID solution. The mass storage controller operates in either AHCI or RAID mode. Changing the mode of
the controller changes the PCl device ID and class code, requiring different device drivers in most operating systems.

HP recommends AMD drivers for HP Compaq Business PC products, including all supported RAID configurations.

WARNING: The PCI Device ID of the mass storage controller changes after changing the BIOS “SATA Emulation”
Computer Setup option. Changing SATA Emulation from AHCI mode to RAID mode is the equivalent of connecting the
hard drives to a new add-on RAID storage controller. The installed operating system on the hard drive is unaware of this
new mass storage controller. If the operating system does not have the RAID drivers installed, the operating system will
fail to boot. For example, All Microsoft 0Ss will cause a blue screen and/or reboot when attempting to boot in RAID mode
without the RAID drivers installed.
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Other supported configurations
HP Compaq Pro 6305 Business PC products support two other RAID configurations:

e Two hard drive configuration.
— Two equal size/type SATA hard drive RAID configurations in RAID O or RAID 1.
— Maximum of two SATA optical drives.
e Three hard drive configuration (only on HP Compagq Pro 6305 Microtower).
— Three equal size/type SATA hard drive RAID configurations in RAID 0.
— Maximum of one SATA optical drive.

Unsupported configurations

HP Compaq Pro 6305 Business Desktop PC products only support the best user experience and highest possible
reliability. As a result, HP does not support the following combinations of RAID hard drives:

Different sizes.

Different speeds (5400 rpm, 7200 rpm, etc.).

0ld and new technologies (SATA 1.5 GB and SATA 3.0 GB).

NCQ hard drives and non-NCQ drives.

RAID combinations of hard drives with any operating system other than Microsoft Windows.

RAID configurations of two or more 10,000 RPM hard drives.

11



Table 6: Non-RAID drive detection scheme

Operation RAID 1 or 0,
Working RAID 1 Degraded,
No RAID Configured
Add blank HDD (hard disk drive) Add HDD as RAID Ready,
Add HDD as Raid Ready (RAID 1 auto-rebuild when hot plug blank HDD only) [1],
Add HDD as RAID Ready
Add HDD with MBR and MDD Add HDD as whatever RAID mode defined in the MDD of the HDD,
Add HDD as JBOD,
Add HDD as RAID Ready
Add HDD with MBR and no MDD Add HDD as whatever RAID mode defined in the MDD of the HDD,
Add HDD as JBOD,
Add HDD as RAID ready or as Spare Drive [2]
Add HDD with MDD and no MBR Add HDD as RAID Ready [1],
fjoch 35) aLD but has been Add HDD as RAID Ready (RAID1 auto-rebuild when hotplugging blank HDD only) [1],
elete
Add HDD as RAID Ready [1]
Add HDD with MDD and no MBR Add HDD as Spare Drive [2],
Auto-rebuild (RAID1 auto-rebuild can directly work with Spare Drive),
Add HDD as Spare Drive [2]
NOTES:

[1] You can “clean” an HDD by selecting Secure Erase in Fusion Controller HUBA75 Option ROM to make sure no MBR or MDD data is left
on the HDD.
[2] Spare Drive can be configured from RAIDXpert. It will write a flag into MDD for driver and Option ROM to recognize it as Spare Drive.

IMPORTANT

The rebuild process does not automatically occur when a drive is plugged in; this
is by design to protect the accidental plug-in of a data drive (diagnostics or
backup). The newly added drive needs to be defined as a spare drive via
RAIDXpert. The BIOS will continue to flag the error condition until the rebuild
process is completed. Note: If the tab to define the drive as a Spare is grayed out,
use the Secure Erase feature to erase any metadata that may exist on the drive.
After the drive is erased, the tab to define the drive as a Spare will be selectable.
Also, if the new drive appears as a Logical Drive, delete this Logical Drive in order
to define it as a spare.

Configuring RAID on non-factory preinstalled configurations

The remaining sections of this white paper describe steps to set up supported RAID configurations where customers
have not purchased factory preinstalled RAID configurations.

WARNING: Before configuring RAID in the Option ROM interface, be sure to back up all data. Once a RAID configuration is
saved, the drives will no longer be bootable until an operating system is re-installed.

Enabling RAID through F10 System BIOS

Turn on or restart the computer by clicking Start > Shut Down > Restart the Computer.
2. Press F10 as soon as the monitor light turns green.

Note: If you do not press F10 at the appropriate time, you must restart the computer, and then press F10 again to
access the utility.
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Use the arrow keys to select the Storage menu.

Use the down arrow key to select Storage Options, and then press Enter.
On the Storage Options menu, use the down arrow key to select SATA Emulation.
Press the right arrow key until RAID displays, and then press F10 to accept.

o e W

Hewlett-Packard Setup Utility
Security Power Advanced

pevice Configuration
Storage Options

DPS Self-test Storage Options
Boot Order SATA Emulation PRAID Mode
e . eSATA Port Disabled
Max eSATA Speed Auto
Removable Media Boot Enabled

Fl0=Accept, ESC=Cancel

7. Toapply and save changes, select File > Save Changes and Exit
— If you do not want to apply your changes, select Ignore Changes and Exit.
— Toreset to factory settings, select Apply Defaults and Exit.

NOTE: Applying default settings never changes or resets the SATA Emulation mode. This setting must always be
changed by selecting the appropriate mode from the F10 Setup Utility under Storage Options.

CAUTION: Do NOT turn the computer power off while the ROM is saving the F10 Computer Setup changes as the CMOS
could become corrupted. Only turn the computer off after exiting the F10 Setup screen.

Configuring RAID Option ROM

You can only access Computer Setup at system startup. To access the Computer Setup Utilities menu and enable RAID:

1. Turnon or restart the computer by clicking Start > Shut Down > Restart the Computer.

Press Ctrl + F as soon as the monitor light turns green to enter the RAID configuration utility. If you do not press Ctrl
+ F at the appropriate time, you must restart the computer, and then press Ctrl + F again to access the utility.

13



The screen below displays briefly during boot up. The RAID configuration utility is English only. To configure RAID in
other languages, use the Web-based RAID configuration utility.

ption KUHW Version 3.3.1593.19
» Advanced Micro Devices, Inc All rights

D Mode LD Nane yize Statu

RAID 1 Logical Drive 1 319.99C Functional

3 <Ctr|-F> to enter RAID Option ROM Utility...

Configuring RAID Volume using the Option ROM

Once you are in the Option ROM you can access the Utility Main Menu by pressing Ctrl + F.

WARNING: Before configuring RAID, be sure to back up all data. Once a RAID configuration is executed and saved, data on
the selected disks will no longer be retrievable.

1. From the Main Menu press 3 to access the Delete LD screen. Use the arrow keys to select the drives. Press Del or Alt
+ D to delete the drives. At the prompt, press Ctrl +Y to delete or any other key to abort. Repeat until all drives are
deleted. Press Esc to return to the main menu.

2. From the Main Menu press 1 to access the View Drives Assignments screen. The View Drives Assignments screen
(below) displays a detailed description of available physical drives, including channel, size and status.

Ly
Port:ID Drive Model Capabilities Capacity(CB) Assignnent
‘@1:A1 WD32BBAAJS-6BZBAB SATA 3G 328.87 B
[S.N.A.R.T.] Hea [th
Extent 1 320.88 LD 1-1
HD328BARJS-6BZBAB SATA 36 328.87
[S.H.A.R.T.] Health
Extent 1 J28.8 LD 1-2

_——
— | ———
[Ctr1+H] Secure Erase[Ctrl+V] View Backup Disk

[ESC] Exi [PU-/PD] Switch PE&

— e[ Keys Available

Press Esc to exit and return to the Main Menu (following image).
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View Drive Assignnents

LD View » LD Define Menu
Delete LD Menu

Controller Configuration .....

[ESCIExit

From the Main Menu, press 2 to access the Define LD screen. This screen allows you to configure RAID settings and
assignments.

‘Advanced Micro Devices, Inc.

RAID Mode Drv Capacity(GB) Status

319.99 Functional

(11 Up [11 Down [Pglp/Pgdnl Switch Page [Del/Alt+D]1 Delete LD

Use the arrow keys to scroll to the desired LD number and press enter. The following screen appears. For RAID 1
configurations, accept the HP default settings.

LD No LD Nane RAID Mode Drv Capacity(GB)
11 RAID 1 ) 2 .9

Stripe Block NA Sector Size 512 B
Read Policy Read Ahead Hrite Policy HriteBack

Port:ID Drive Model Capabilities Capacity(GB)

81:@1 SSD U188 64CB SATA 6C 64 .82
#3:81 HWD2588AARJS-6B8B4AB SATA 3C 258 .85

15
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For all other configurations:

a. Use up and down arrow keys to toggle and the space bar to view and change options.
b. Under Assignment, select Y to enable the drive(s).

c. Press Ctrl +Y to save your settings.

d. Atthe prompt, press Ctrl + Y to Modify Array Capacity or press any other key to use maximum capacity.
e. Press Esc to exit and return to the main menu.

Press Esc to exit. At system prompt, press Y to reboot or any other key to go back.



Select boot order

To set up your system to boot from the 0S media, you may need to change the boot order in the F10 setup menu.
Turn on or restart the computer by clicking Start > Shut Down > Restart the Computer.

2. Press F10 as soon as the monitor light turns green.

If you do not press F10 at the appropriate time, you must restart the computer, and then press F10 again to access
the utility.

3. Usethearrow keys to select Storage.
Use the down arrow key to select Boot Order, and then press Enter.

5. Use the down arrow key to select ATAPI CD-ROM Drive, and then press Enter. Press the arrow key up to the desired
position in the boot order. Press Enter again and F10 to accept the change.

6. Toapply and save changes, select File > Save Changes and Exit.
— If you do not want to apply your changes, select Ignore Changes and Exit.
— Toreset to factory settings, select Apply Defaults and Exit. This option restores the original factory defaults.

Notes for operating system installation
After creating a RAID disk volume in the option ROM and selecting the boot order, the operating system can be installed.
Before proceeding, you will need the following:

e Microsoft Windows 0S media and Product Key.

e RAID driver UFD. To create, go to www.hp.com/support. Select your country and language, select Support and Drivers,
click on Drivers and Software, enter the model number of the computer, and press Enter.

The following steps apply to Microsoft Windows 0S installations.

1. Insert the Windows 0S media and reboot the computer.
2. Press F9 at the prompt to begin installation.
3.  When the load driver error window appears (below), insert the RAID driver UFD and click Browse.

Select the driver to be installed.

Load Driver
A required CD/DVD drive device driver is missing. If you have a driver floppy disk, CD,
DVD, or USB flash drive, please insert it now.

Note: If the Windows installation media is in the CD/DVD drive, you can safely remove it
for this step.

[ Browse | [ Cancel ]

¥ Hidé anvers urat are ot Commpatiuie WiLtr iaruware o s COrTPULer.

| Browse f | Rescan

17



4. Navigate to the directory where the .inf file is located, select it, and click Next.

5. Atthelicense screen check the “l accept...” box and click Next.
6. Select the partition for the 0S to be installed and click Next.

Where do you want to install Windows?

44 Refresh Drive options (advanced)

&% Load Driver

. Windows cannot be installed to this disk (Show details)

The 0S will install.

Failure to install and enumerate the RAID driver after enabling the RAID controller (with or without creating a volume)
will result in a Windows boot failure (blue screen) for inaccessible boot device.

WARNING: The PCI Device ID of the mass storage controller changes after changing the BIOS “SATA Emulation” Computer
Setup option. Changing SATA Emulation from AHCI mode to RAID mode is the equivalent of connecting the hard drives to
a new add-on RAID storage controller. The installed operating system on the hard drive is unaware of this new mass
storage controller. If the operating system does not have the RAID drivers installed, the operating system will fail to
boot.

Additional technical information will be provided in the future for customers who want to add RAID SW image
deployment capabilities.

18



AMD Array Management Software (RAIDXpert)

This section of the paper focuses on how to configure RAID using AMD Array Management Software (RAIDXpert).

Java Runtime Environment

RAIDXpert will install JRE 1.4 on your system unless you already have JRE versions 1.3.0 or 1.4.

Console Software Installation

The RAIDdriver softpaq also provides the AMD RAIDXpert utility, which you can install by running the setup.exe program
provided.

Log-in to RAIDXpert
1. Double-click on the RAIDXpert icon on your desktop.

2. When the opening screen appears, type admin in the Login ID field. Type admin in the Password field. Note: The
RAIDXpert login and password are case sensitive.

3. Click the Sign in button.

AMD
F‘]AEDXp@Pt Language p English  Contact Us

password : ST v
n}

© 2012 Advanced Micro Devices, Inc. All rights reserved.

Recommended Initial Settings

These recommended settings are most effective if you accept the initial recommended settings now. You can change
them later as necessary.

Administrator’s Settings

To setup the Administrator’s password and notification settings:

1.  InTree view, under Administrative Tools, click on User Management.

2. Inthe User Management Window, click on the admin link.
3. Click the Create tab.

19



AMD
HA' Dxpe r't Language p English Show Event ContactUs lLogout Help

User Management
User Management

Host Management
Utility Configuration
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To change the default password:

1. Type the new password into the Password field. Use up to 8 letters and numbers but no spaces or other characters.
2. Type the same password into the Retype Password field.

To set up the Recipient email for Event Notification:

1. Type the Administrator’s email address in the Email field.

2. Click on the Submit button. If the action was successful, the Management Window will display the message “Update
Success.”
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To set up Event Notification:

1.

Click on the Events tab.

AMD
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Wosk Augged in M 0ss 2L Lictate Ok B3, Cleared

Check the notification events that you want reported to you via email and popup messages. To select events by
their severity, check one of the four “Select All” event boxes at the top of the window.

Click the Submit button, Utility Configuration.

To set up Sender’s email for Event Notification:
1.

e W

In Tree View, under Administrative Tools, click on Utility Configuration.
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Time Desc.
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System Event System Event
Notification Dialog = O Enable ® Disable Notification Dialog

Digplay Desc.

Simplified Backup
Dialog Display Desc.

Enter the Sender’s address in the Email Server field. Be sure the sender has an account in your email system.
Keep your email server in the Email Server field.

Keep the default or specify a custom one in the Email Subject line.
Click the Submit button when you are done.
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Degradation

In the unlikely event that one of your hard drives malfunctions, RAIDXpert reports the condition with popup messages. If
Event Notification is set up, RAIDXpert also reports the conditions with email messages.

For More Information

An HP online support document further describing setting up RAID using AMD RAIDXpert is available at the following web
page:

http://h20000.www?2.hp.com/bizsupport/TechSupport/Document.jsp?objectiD=c01827420

Get connected
hp.com/qgo/getconnected

Current HP driver, support, and security alerts
delivered directly to your desktop
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